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Be sure your product is up-to-date by checking for the latest patches on the Patch page.
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How do I Install PASW Data Collection and Survey Visualization Server 5.6 Products?

For information about installing PASW Data Collection and Survey Visualization Server 5.6 products, see the Installation Instructions. You can view these by selecting Installation Instructions from the Installer window.

Important: You cannot upgrade from the PASW Data Collection and Survey Visualization Server 5.6 Beta to the official PASW Data Collection and Survey Visualization Server 5.6 release. If you currently have the PASW Data Collection and Survey Visualization Server 5.6 Beta installed, you will need to completely uninstall the beta applications before installing PASW Data Collection and Survey Visualization Server 5.6.
If the Installer window does not open automatically when you insert the CD-ROM into the CD-ROM drive, you can open it manually. There are two ways to do this. Browse the CD-ROM using Windows Explorer and double click the autoplay.exe file. Alternatively, choose Run from the Windows Start menu, and then enter d:\autoplay in the Run dialog box, where d:\ is the CD-ROM drive.

Documentation for PASW Data Collection and Survey Visualization Server 5.6 Products
Additional technical documentation is provided in the PASW Data Collection Developer Library 5.6, which is available on the PASW Data Collection and Survey Visualization Server CD-ROM.

Viewing Documentation on a Remote Server

Security updates for Microsoft Windows may prevent you from viewing the PASW Data Collection and Survey Visualization Server Installation Instructions, the PASW Data Collection and Survey Visualization Server User Guide help systems, or the DDL if they are located on a remote server. You may find that the help window opens with an empty topic pane or that the topic pane contains the message “The page cannot be displayed”. To resolve this problem, copy the .chm files to the local machine and open the files from there. For more information about this issue, see http://support.microsoft.com/kb/892675/ and http://support.microsoft.com/kb/896054/.
Issues Resolved in 5.6
Interviewer Server Administrator - DimensionNet and DimensionNet Activities

· 26750
During installation, you can now specify a custom port number for the database server.
Interviewer Server - mrInterview

· 47494
The radio buttons that specify whether to reboot the machine now or later are now visible on the final page of the installation wizard. A blank page no longer displays.

· 92293
When displaying a selection of records, Participants no longer returns no records.
· 102355
You can now select a datetime field when setting the field in which to write the date and time of when an email is sent.

· 103675
After a disconnection, the previous question no longer displays even after the interviewer selects a call outcome.
Web Reports for Surveys - mrTables

46958
Charts are no longer incorrect when values are close and exported to Word 2007.
Reports for Surveys - Reporter

· 41422
Variable list actions are now undoable.
· 47180
Dimensions global filters are no longer visible to Minimum Access users.
· 64610
In Reports for Surveys - Reporter, you cannot delete a grouped set of variables from within a filter using the Delete key.
· 91766
Variable edits no longer disappear after running results on a table.
· 91767
A dummy variable no longer appears in .pkd files opened in Reports for Surveys - Reporter.

· 91928
You can now group a grouped set of variables on the Filters tab.
· 92486
You can now create a new categorized variable after de-selecting the Generate the "Other" category for any other uncategorized data option.

· 102259
Professional - mrStudio no longer function improperly when you access the Web interface of Reports for Surveys - Reporter from a workstation running an earlier version of Professional - mrStudio.
· 102648
Exporting data from Reports for Surveys - Reporter to a Quantum .dat file no longer results in an empty .dat file.
· 102695
Quanvert grid variable descriptions now appear under the Description column in Reports for Surveys - Reporter.

The Table Object Model

· 32207
Built-in tstats in Quanvert axes are recognized by Reports for Surveys - Reporter, and the options minbase, smallbase and elms= are now carried across.
· 92264
Bases within a net are no longer only calculated using the net values.
· 104195
You can now use @ IS NOT NULL in an axis expression.
Data Model

· 92373
If the same script specifies two input and two output files, the second output file now contains case data for any new variables.
· 102646
When writing DMS scripts, using underscores in new variable names no longer causes some records to not be processed, and result in missing case data in the output file.
Known Limitations

Interviewer Server - mrInterview

Interviewer Server - mrInterview: Build
Refer to the Known Limitations for Interview Scripting section for limitations related to the IOM Script item.
· 34357
Removing a question that is the target of a GoTo causes errors.
· 34498
When creating a categorical question using the Hebrew language the response name removes the first letter in the word (for Hebrew this is the right most character) and replaces it with an underscore. This means that when defining a routing object, such as If..Goto, then the response name can be difficult to read. If you want to see the full name, alter the variable names manually by placing an underscore before pasting in the complete Hebrew word. This will stop the name dropping any of the Hebrew characters.

· 37573 
If an .mdd file contains a grid that uses shared lists for the question subjects and responses, inserting that file into a questionnaire using File, Insert, From File causes the response categories to be blank.

· 39506
Items names cannot be re-used in a questionnaire even if the original item no longer exists. 
· 40527

The screen for an If…GoTo item does not resize to handle long question names, with the result that the And>> and Delete buttons are no longer visible. You can work around this issue by entering the routing syntax manually on the Advanced tab.

Interviewer Server - mrInterview: Email
· 35407
An unhelpful message is written to the SEM log file when the email port is blocked by a virus scanner when sending test emails. The message is "Failed to send mail. [Error number: 9] Message: An exception has occurred."
Interviewer Server - mrInterview: Export Data
· 24222
Japanese characters are incorrectly exported to Quantum. Note, however, that Quantum does not support Japanese characters.
· 119706
In some cases, selecting an activated project, starting Export Data activity, and clicking Download Now (using default settings) does not work as expected. The issue is due to the validation of specific parameters. When validating parameters, some hidden parameters fail. As a workaround, you can first download Quantum data (Quantum data in not affected by this issue), then download other data formats.
Interviewer Server - mrInterview: Interviewer Monitoring
· 140634 - 43372

Interviewer Monitoring's list of active sessions does not distinguish between live interviews and review sessions.
Interviewer Server - mrInterview: Interview Scripting 

If your interview templates are not being applied in Professional/mrStudio, look for an error message in the log file created in the C:\Documents and Settings\your Windows user name\Application Data\SPSS\DimensionNet\Logs folder. You can also use the HTML Tidy menu option to ensure that your templates contain well-formed XML.

· 24477
Questions do not appear in the interview if they are asked in a function. This problem may occur if you attempt to present a repeated set of questions on separate pages by using the LoopName[..].Ask() syntax. Only the last iteration of the loop appears in the interview. Future versions of the interview scripting language may not support the use of Ask() and Show() in a function, so we recommend that you restructure the script so that these methods do not appear inside a function.

· 32204
The contents of arrays disappear when navigating to a previous question or restarting the interview, either after stopping the interview or after timing out.

· 46509

Setting Font.Efffects to Null in the routing section does not override the default setting in the template.

Interviewer Server - mrInterview: Launch, Promote Project, and Activation components
· 25327
If template (.htm) files are checked in to the Shared folder, they are not copied to the Master folder or the Projects folder when the project is activated. The getaround is to check the template files out before activating.
· 102143
If you disable and then re-enable sample management for a project, your original sample management parameters are not recognized. In this case, you must re-configure sample management options.
Interviewer Server - mrInterview: Participants
· 39020
Uploading records to a new database on a project that has already been activated, when the new records contain fewer fields than previously, does not update the list of sample management fields. This means that reactivation fails because it is unable to find the original sample management fields.
Interviewer Server - mrInterview: Phone Participants
· 46239
When dialing predictively, Phone Participants can start working in an unexpected manner if the interviewing engine fails when the interview is on the last page and then completes. Attempting to reconnect to the participant results in runtime error messages or instructions to contact the interviewing supervisor.

Interviewer Server - mrInterview: Quota Setup
· 28138
When you change a quota’s dimensions (for example, you change a quota based solely on gender so that it is based on gender and age combinations), Quota Setup warns you that this will destroy the quotas you have previously created and asks whether you wish to continue. If you choose to continue, and then reactivate the project and synchronize the quota database, the Quota activity in Interviewer Server Administrator - DimensionNet will show no quota tables for the project.

To avoid this problem, do not change a quota’s dimensions. Instead, consider converting the existing quota so that each cell uses an expression to define the quota’s characteristics. For example, you could change the male and female quotas so that they refer to a gender and age combination, and then add new expressions for the remaining combinations. This gives you the quotas that you require without changing the dimension of the quota itself.

· 91779
After deleting a quota table, you cannot create a new quota table with the same name but a different table definition. If you do so, the next time you open the quota defintion (.mqd) file, the new table is renamed “Group 1” and the table definition reflects the original quota table.
Interviewer Server - mrInterview: Review Quotas

· 46508

Setting prioritization for one quota and then immediately attempting to set prioritization for a second quota displays the settings for the first quota. Canceling the selection and the reselecting the second quota displays the correct information.

· 47012

Changing targets in Review Quotas updates the quota tables in the quota database but does not update the corresponding figures in the .mqd file. This means that if you then edit the quotas using Quota Setup, the changes to the targets that you made in Review Quotas will be lost once you reactivate the project. The workaround for this problem is to change targets using the Quota Setup program rather than Review Quotas.
Interviewer Server - mrInterview: General Issues
· 33586
Using a URL for the Authentication page on Dimensions projects does not redirect the respondent to authretry.htm if the Id is incorrect.

· 34297
If the first row of a filtered grid does not contain all columns then the column headings do not appear.
· 92289
When an interview starts, mrInterview changes null values in sample fields to blank (“”) values.
Web Reports for Surveys - mrTables

Web Reports for Surveys - mrTables: Load Balancing

A number of problems have been found when using Interviewer Server Administrator - DimensionNet load balancing with mrTables. It is therefore recommended that you do not use Interviewer Server Administrator - DimensionNet load balancing with Web Reports for Surveys - mrTables. Load balancing using other methods, for example, IIS load balancing or hardware accelerators, works correctly.

Web Reports for Surveys - mrTables: Exporting charts to Word

When you use the option to export charts to Word, the Word Export component creates the charts using Excel. This requires that Word is installed with the option to embed Excel charts enabled. If this option is not enabled, exports of charts to Word will fail. 

To see whether this option is enabled:

· Start a new document in Word.

· From the Insert menu, choose Object.

· From the list of object types, select Microsoft Excel Chart.

· Click OK.

If this fails, it generally means that the option is not enabled and you will need to install the option before you can export charts to Word. 

Web Reports for Surveys - mrTables: General Issues

15373, 16882
When text-only elements are used on the top axis of a table, they are displayed as an empty column. You can work around this problem by not using text-only elements on the top of the table. When variables have these elements built in, you can remove them using the Edit Axis dialog box when necessary. 

27226
In the Variable List, dragging and dropping a variable name onto the table structure is no longer possible. This is a result of Microsoft Security update 824145. It is still possible to drag and drop the variable by clicking and dragging the variable icon. Alternatively, click the variable name in the Variable List once, then move the cursor to where you want to place the variable and click again.
31871
In some circumstances, population of tables in the Web Reports for Surveys - mrTables user interface is taking longer than when the same tables are created using a script.
47220

A “RegisterAppWithDPM” error message is encountered when re-installing Web Reports for Surveys - mrTables via the Repair option.
179207
Some pages do not display well in Internet Explorer 6.0. For best results, use Internet Explorer 7.0.
Reports for Surveys – Reporter

Note: Most of the known problems in this section also apply to the desktop version of Reports for Surveys - Reporter.
· 45378
Reports for Surveys - Reporter will occasionally encounter an error when populating results using Sort by Column Significance.
· 45468
You cannot change a variable name, and then change the name back to its original value.
· 102913
The Web deployed version of Reporter does not have as many stylesheet options as the desktop version.
· 103423
When running table results from a .pkd file, Reports for Surveys - Reporter ignores calculations done with the Keep and OP= options applied in Quantum.
Data Model

· 33238, 33683, 35835
DM Query does not correctly display multi-byte category names.
36966
The Quantum DSC does not recognize { as a valid punch character.
43948
The result of the following expression in mrScriptBasic is False:
If ((0.05 + 0.01) = 0.06) Then

Documentation

Interviewer Server

The “What’s new in Interviewer Server 5.6” topic does not include information for the following new features:

· Asynchronous activation. Each activation request is now added into a queue. The new Activation History activity allows you to monitor the activation queue. The Activation Settings options allow you to manage the activation queue.
· Activation settings. Allows you to monitor the activation queue. Activation settings are available from the Options menu.
Web Reports for Surveys

The “What’s new in Web Reports for Surveys 5.6” topic does not include information for the following new features:

· Rounding Options. You can now specify the default rounding calculation.
Third Party Software Legal Notices
Elvis Text Editor

Portions of this Software includes Elvis Text Editor and a copy of the software and related instructions may be found at http://elvis.the-little-red-haired-girl.org/gettingelvis/index.html
Rapid Shell Desktop 3.6

A portion of this Software is third party software licensed from Keyoti Inc. (http://www.keyoti.com)

Boost Software License - Version 1.0 - August 17th, 2003
Permission is hereby granted, free of charge, to any person or organization obtaining a copy of the software and accompanying documentation covered by this license (the "Software") to use, reproduce, display, distribute, execute, and transmit the Software, and to prepare derivative works of the Software, and to permit third-parties to whom the Software is furnished to do so, all subject to the following: The copyright notices in the Software and this entire statement, including the above license grant, this restriction and the following disclaimer, must be included in all copies of the Software, in whole or in part, and all derivative works of the Software, unless such copies or derivative works are solely in the form of machine-executable object code generated by a source language processor.
THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, TITLE AND NON-INFRINGEMENT. IN NO EVENT SHALL THE COPYRIGHT HOLDERS OR ANYONE DISTRIBUTING THE SOFTWARE BE LIABLE FOR ANY DAMAGES OR OTHER LIABILITY, WHETHER IN CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE OR OTHER DEALINGS IN THE SOFTWARE.
JDBM LICENSE v1.00

*

* Redistribution and use of this software and associated documentation

* (""Software""), with or without modification, are permitted provided

* that the following conditions are met:

*

* 1. Redistributions of source code must retain copyright

* statements and notices. Redistributions must also contain a

* copy of this document.

*

* 2. Redistributions in binary form must reproduce the

* above copyright notice, this list of conditions and the

* following disclaimer in the documentation and/or other

* materials provided with the distribution.

*

* 3. The name ""JDBM"" must not be used to endorse or promote

* products derived from this Software without prior written

* permission of Cees de Groot. For written permission,

* please contact cg@cdegroot.com.

*

* 4. Products derived from this Software may not be called ""JDBM""

* nor may ""JDBM"" appear in their names without prior written

* permission of Cees de Groot. 

*

* 5. Due credit should be given to the JDBM Project

* (http://jdbm.sourceforge.net/).

*

* THIS SOFTWARE IS PROVIDED BY THE JDBM PROJECT AND CONTRIBUTORS

* ``AS IS'' AND ANY EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT

* NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND

* FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL

* CEES DE GROOT OR ANY CONTRIBUTORS BE LIABLE FOR ANY DIRECT,

* INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES

* (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR

* SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION)

* HOWEVER CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT,

* STRICT LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE)

* ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED

* OF THE POSSIBILITY OF SUCH DAMAGE.

*

* Copyright 2000 (C) Cees de Groot. All Rights Reserved.

* Contributions are Copyright (C) 2000 by their associated contributors.

EasyMail Objects 6.0

This application utilizes a licensed copy of EasyMail objects.  EasyMail Objects is Copyright © 1997-2001 Quicksoft Corporation.  All rights reserved. Use of any objects outside the context of this application is a violation of United States and international copyright laws and other applicable laws.
Ultimate Toolbox

This software contains material that is (c) 1997-1998 DUNDAS SOFTWARE LTD., all rights reserved.
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